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GuidosToolbox Workshop

The workshop will address the following topics:

GWS 1: Introduction/motivation for new ways of image analysis
GWS 2: Pattern Analysis (M)SPA
GWS 3: GuidosToolbox: program features and processing options
GWS 4: Hands-on examples using training data:
   a) Data preparation, MSPA, Google Earth overlays, batch process
   b) Distance, fragmentation, network, restoration, change, … 
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GuidosToolbox Workshop

File:
File management, 
Batch-processing,
Change analysis…

General Tools:
Pre-processing, 
generic image filters,  
GIS software… 

Image Analysis:
Dedicated thematic 
image analysis tools…  

Help:
Program documentation, GTB 
product sheets, workshop 
material, further resources …  

• Input: categorical raster maps, binary/grayscale masks, land cover, resistance maps, …
• Output: thematic feature maps and statistics, Google Earth image overlays, … 

(GTB Manual: https://ies-ows.jrc.ec.europa.eu/gtb/GTB/GuidosToolbox_Manual.pdf)

Key features grouped in 4 menus  

https://ies-ows.jrc.ec.europa.eu/gtb/GTB/GuidosToolbox_Manual.pdf
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GuidosToolbox Workshop 1. File → Read/Save Image  

Read input image

Read Image: Various raster image
input formats, default: GeoTiff 

Generic
IP Software

Save Options (image & statistics)

Save Image: Various raster image 
output formats, default: GeoTiff 
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GuidosToolbox Workshop 1. File → Batch Process 

Batch Process: Similar options as 
in Image Analysis menu section

1. Select batch processing type
2. Select folder with your input images: 
3. Set processing options
4. Results in parent folder: batch_type

1
2

4
3



6

Change: Similar options as 
in Image Analysis menu section

GuidosToolbox Workshop 1. File → Change

1. Select change type
2. Select two matching input images 
3. Results in GTB

1

3

2

3
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GuidosToolbox Workshop 2. General Tools → Preprocessing

Setup/modify your image.

• Convert data type

• Tri-band to single layer 

• Reproject for Google Earth

• Setup batch recoding

• Recode image classes or regions

• Threshold to binary image

• Assign FG/BG/Missing

• Invert class assignment

• Shift class value up or down

Use any of these options, or combine them with other 
General Tools, for a custom setup of your image.
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GuidosToolbox Workshop 2. General Tools → 

• Convolution filters

• Custom, user-defined filter

• Equalization, Interactive Tresholding

• Edge detection and enhancement

• Morphological Toolbox

• GIS Software: 

GTB-Terminal 

OpenEV Viewer

3

Setup/modify your image. Choose from a variety of image filters:

1 1
2

2
3

4

4

5
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GuidosToolbox Workshop 3. Image Analysis → Objects  
Accounting: Group objects in up to 6 user-defined area classes

1) Define area size-classes

2) Resulting map and statistics

Accounting product sheet

https://ies-ows.jrc.ec.europa.eu/gtb/GTB/psheets/GTB-Objects-Accounting.pdf
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GuidosToolbox Workshop 3. Image Analysis → Objects  
Parcellation: Splitting index for each land cover class and the entire image

Features: 
- Summary for all objects & for all classes
- Normalized index
- Detect and measure the dominant parcellation class

Low: 
Homogeneous land cover, low fragmentation, 
few/large land cover classes 

High: 
Heterogeneous land cover, Highly fragmented 

Parcellation product sheet

https://ies-ows.jrc.ec.europa.eu/gtb/GTB/psheets/GTB-Objects-Parcellation.pdfhttps:/ies-ows.jrc.ec.europa.eu/gtb/GTB/psheets/GTB-Objects-Parcellation.pdf
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GuidosToolbox Workshop 3. Image Analysis → Objects  
Contortion: Measure the regularity of object perimeters

Features:
Low count: regularly 
shaped objects 
(agricultural fields, 
buildings, etc.)
Anthropogenic 

High count: 
Natural objects

User can define minimum
object size of interest & set
threshold to group contortion
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GuidosToolbox Workshop 3. Image Analysis → Pattern
SPA2/3/5/6: Simplified Pattern Analysis in 2-6 classes including CoreOpening
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GuidosToolbox Workshop 3. Image Analysis → Pattern
MSPA: Spatial Pattern Analysis in up to 25 classes

Features:
1. Flexible processing via 
    four MSPA-parameters 
2. Detailed statistics 
3. Core grouping
4. Corridor detection (Bridge)
5. Measure area of holes1

2 4

3
5

Pattern product sheet
Pattern website

https://ies-ows.jrc.ec.europa.eu/gtb/GTB/psheets/GTB-Pattern-Morphology.pdf
https://forest.jrc.ec.europa.eu/en/activities/lpa/mspa/
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GuidosToolbox Workshop 3. Image Analysis → Pattern

MSPA Tiling: MSPA for large maps. Warning: very slow & potentially incorrect! 

1. Select geotiff input image  
2. Set MSPA-parameters  
3. Accept: let GTB do the job…

a) Cut buffered sub-tiles
b) MSPA loop over buffered sub-tiles
c) remove buffers and reassemble 
d) save the final result as geotiff

1 2

Correct solution: use GWB_MSPA when processing large maps!

https://gwbdoc.readthedocs.io/en/latest/usage/GWB_MSPA.html
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GuidosToolbox Workshop 3. Image Analysis → Pattern
Moving Window: Various kernel filters, e.g., counting adjacencies (contagion)

Features:
1. Select analysis type  
2. Set kernel-parameters  
3. Accept: start analysis

4. Mask FG-switch
5. Color-group range settings

1

2

3

5

4
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GuidosToolbox Workshop Input/output formats  3. Image Analysis → Pattern
Landscape Mosaic: Measure land cover composition and human impact

Heterogeneity in Agriculture/Natural/Developed
(at user-selected observation scale)

Land cover map

Agr./Nat./Developed

Measure composition
• Geometric concept
• Monitor & quantify

influence of the three 
components

• Heatmap summary 

LM product sheet
LM paper

https://ies-ows.jrc.ec.europa.eu/gtb/GTB/psheets/GTB-Pattern-LM.pdf
https://doi.org/10.1371/journal.pone.0304215
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GuidosToolbox Workshop 3. Image Analysis → Network
Network: NW-components; importance of connectors and habitat patches…

- Use MSPA to 
detect habitat 
patches/corridors

- Conversion to Nodes & Links

- Use graph theory to rank and 
locate the most important 
corridors and habitats in the 
current network (highest priority
for protection/conservation)

dPCintra > 0
dPCflux = 0
dPCconnector = 0

dPCintra > 0
dPCflux > 0
dPCconnector = 0

dPCintra > 0
dPCflux > 0
dPCconnector > 0

NW-components
Node/Link-importance

Additional options:
- Component connectors
- Setup input data for 
graph-theory analysis 
e.g., in Conefor

MSPA+Network analysis paper

http://www.conefor.org/
http://doi.org/10.1016/j.foreco.2011.03.017
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GuidosToolbox Workshop 3. Image Analysis → Network
Graph theory: Requires two tables: Nodes & Links. You have 2 options in GTB:

Links = MSPA-class Bridge

Input image: MSPA image

Additional options:
- Select FG-connectivity
- Select distance type
- Accept: write out input tables for 
graph-theory analysis in Conefor

1.) MSPA ConeforInputs

2.) ConeforInputs

Nodes = MSPA-class Core

MSPA     →  Graph Theory

→ 

Connectivity: defined by MSPA

Connectivity: defined by  Euclidean distance threshold

Input image: raster image with network objects assigned to 2 byte

Conefor

http://www.conefor.org/
http://www.conefor.org/
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GuidosToolbox Workshop 3. Image Analysis → Fragmentation
Fragmentation: Choose from indices to map products to multiscale analysis…

1) Select type of input, method, reporting, scale, etc.

2) Resulting map and statistics 
showing the degree of 
fragmentation in 2-6 classes for 
the selected observation scale.

Binary vs grayscale paper
Fragmentation product sheet

https://doi.org/10.1016/j.ecolind.2024.111695
https://ies-ows.jrc.ec.europa.eu/gtb/GTB/psheets/GTB-Fragmentation-FADFOS.pdf
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GuidosToolbox Workshop 3. Image Analysis → Distance
Euclidean: Pseudo elevation map showing shortest distance to FG/BG boundary

Distance [m]

- Locate compact habitat 

- Distance to habitat boundary 

- Hypsometric curve summary

Distance product sheet

https://ies-ows.jrc.ec.europa.eu/gtb/GTB/psheets/GTB-Distance-Euclidean.pdf
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Influence Zones: Distance between selected objects
GuidosToolbox Workshop 3. Image Analysis → Distance

Features:
1. Select minimum object area of interest  
2. Set FG-buffer to define Core objects  
3. Set BG buffer for Outreach Zone

1

2 3

Neglected:
- object < min. object area, or
- buffer into foreground

Outreach Zone into background 

Watershed: equal distance 
between neighboring objects) 

Outreach Zone boundary 
3

2
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GuidosToolbox Workshop 3. Image Analysis → Distance
Proximity: Locations where pairwise distance < X (restoration planning)

Features:
1. Select minimum object area of interest  
2. Set FG-buffer to define Core objects  
3. Set proximity threshold
4. Mouseover component ID/area
5. Mouseover watershed: proximity between neighb. 
components and Connected Area Gain (CAG)

1

2 3

4

Distance < Proxmax Min. proximity
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GuidosToolbox Workshop 3. Image Analysis → Restoration Planner  
Setup Tools: Guided help to define resistance or marker maps

Fixed BG-Resistance: assign a constant 
resistance value to all background pixels:

Land Cover → Resistance: assign or reclassify
land cover class-specific resistance values:

Distance → Resistance: ~ distance
from FG-objects (birds/flying insects):

Distance: low High (≥ 100 pixels)

Pixel → Resistance: assign custom
resistance value to a given pixel:

Line → Resistance: 
1) draw a freehand or straight line
2) assign width/resistance value

1

2

Resistance [%]: proxy for restoration effort
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GuidosToolbox Workshop 3. Image Analysis → Restoration Planner  
Setup Tools: Guided help to define resistance or marker maps

Region Of Interest (ROI) → Resistance: 
assign resistance values to custom regions: • Add new ROI: rectangular, oval,

freehand, or polygon
• Shift or warp the shape of a ROI
• Region Growing to select irregular

feature: setup a small Marker, then
right-click on it for region growing

ROI Selection Tool features:

Irregular feature is selected

• Close window & assign resistance
                       for all ROIs:
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GuidosToolbox Workshop 3. Image Analysis → Restoration Planner  
Setup Tools: Set start/target object for travel time analysis

Resistance Map    +     Marker Map Isochrone Map A    or    Isochrone Map AB

1) Click Start object
& press Enter key:

2) Click Target object
& press Enter key
(optional):

3) Click specific pixel &
press Enter key to define
missing data (optional):

Marker Image is saved
for travel time analysis:
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Assessment: Network status summary and evaluate restoration efficiency
GuidosToolbox Workshop 3. Image Analysis → Restoration Planner  

Status Summary: including 
reachable area (ECA) and 
overall Coherence [%].

Change Summary: gain in
𝝙 ECA and 𝝙 Coherence.

Custom Path: I want this path. 
- Draw Freehand or Straight Line path (1 pixel width)
- Instantly get restoration path statistics

Optimum Path: I want the optimum path 
between two objects of my choice. 
- Interactively select Start & Target object
- Get LCP + cost surface between 2 objects

Optimum Path Travel time

low high
Least Cost Path

Optimum Big 5: best pairwise path between the 5 largest objects

Restoration planner product sheet

https://ies-ows.jrc.ec.europa.eu/gtb/GTB/psheets/GTB-RestorationPlanner.pdf
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Assessment: Network status summary and evaluate restoration efficiency
GuidosToolbox Workshop 3. Image Analysis → Restoration Planner  

Isochrone map: show the travel time (TT) map.
- Isochrone Map A: TT map from object A
- Isochrone Map AB: TT map (A) + TT map(B) = 
  cost surface + optimum path (A↔B)

Resistance Map  +    Marker Map

enlarged area

blocking, i.e. water unreachable

Isochrone Map A Isochrone Map AB

low high
Least Cost Path

TT Map: Evaluate local resistance fields → 
guidance in restoration/conservation planning.

A

A A
A

B

B

B
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GuidosToolbox Workshop 4. Help …  

Help: GTB documentation, GTB and other related online resources, bug report template

SEPAL

!
The GTB Product Sheets:

latest news …

https://forest.jrc.ec.europa.eu/en/activities/lpa/gtb/
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Thank you
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